Hands-on
Drug Discovery on Grid

Ana Lucia Da Costa ‘
HealthGrid, France

ACGRID School
Kuala Lumpur, 10 Nov.2009




EVAsIatrid

“Best ways to put two molecules together.”

AG ?

—
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Molecular Docking: the prediction of the optimal
bound conformation of two molecules exerting
geometrical and chemical complementarity.
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Active HIV protease is
required for viral
infectivity

PDB code: 1hvr

Co-cristallized inhibitor:
XK?2

l\@(@ Chembridge
5 Ramdom compounds
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Docking Programs

DOCK: (Kuntz et al. 1982)
DOCK 4.0 (Ewing & Kuntz 1997)
AutoDOCK (Morris et al. 1998)
GOLD (Jones et al. 1997)

FlexX: (Rarey et al. 1996)
GLIDE: (Friesner et al. 2004)
ADAM (Mizutani et al. 1994)
CDOCKER (Wu et al. 2003)
CombiDOCK (Sun et al. 1998)
DIVALI (Clark & Ajay 1995)
DockVision (Hart & Read 1992)
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FLOG (Miller et al. 1994)
GEMDOCK (Yang & Chen 2004)

Hammerhead (Welch et al.
1996)

LIBDOCK (Diller & Merz 2001)
MCDOCK (Liu & Wang 1999)
PRO_LEADS (Baxter et al. 1998)
SDOCKER (Wu et al. 2004)

QXP (McMartin & Bohacek
1997)

Validate (Head et al. 1996)

~



Autodock EUAsiaGrid

Automated docking of flexible ligands to macromolecules
and designed to predict how small molecules, such as
substrates or drug candidates, bind to a receptor of

known 3D structure.

When is AutoDock not suitable
No 3D structures available;
Modelled structure of poor quality;
Too many (torsions, atoms, types);
Target protein too flexible.
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Genetic algorithm is inspired by evolutionary biology

Genotype = Ligand conformation : a chromosome
constitued by real valued genes representing:
Ligand translational
Ligand orientational Degrees of freedom
Ligand conformational

Phenotype = Coordinates of given conformation
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For each run, Autodock successively:
Create a population of individuals

Assign a random translation, a random orientation and x random
torsions to each individual

Begin Lamarckian Genetic Algorithm (LGA), with a maximum of
energy evaluations and maximum generations

Final Lamarkian genetic algorithm docked state

At the end of each run, Autodock outputs a result which is the
lowest docked energy conformation of the ligand it found during
that run

Lower energy are “better” and in the genetic algorithm “fitter” > RANK
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Scoring function
Scoring function takes a pose as input and returns a number

indicating the likelinood that the pose represents a favorable
binding interaction

AGpinging = AGaw + AGgiee + AGppong +
AGde:so/v + AGtors
AG gy
12-6 Lennard-Jones potential
AGeleC Molecular
Coulombic with Solmajer-dielectric mechanics
AGhbond
12-10 Potential with Goodford Directionality
AGdesolv
Stouten Pairwise Atomic Solvation Parameters
AG

tors
Number of rotatable bonds
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Grid Maps

Autogrid pre-calculate grid maps, one
for each atom type present in the
ligand database + electrostatic map

Docking calculations extremely fast
~100x faster

A grid map consists of a three
dimensional lattice of regularly spaced
points surrounding the active site

Each point within the grid map stores
the potential energy of a “probe” atom
that is due to all the atoms in the
macromolecule

grid spacing /A

-—

grid point\

probe atom——"
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Preparation with Autogrld

Ligand Database Macromolecule
PDB or Mol2 PDB
Prepare _ligand.pv I I Manually
pare_iigand.p v VW with AutodockTools
All atom types PDBQS
in database I -

AMGA
Manually with ADT q
Es
Macromolecule.gpf Autodock
Autogrid3 Protein
M v W te
acromolecule. glg ‘o Sov. Aoy
Macromolecule.atom.map Aok o
Macromolecule.e.map Compounds
Macromolecule.maps.fld
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Visit http://www.pdb.org/

EVAsIiaGrid

& MyPDB Login ] = 8] =

An Information Portal to Biological Macromolecular Structures
As of Tuesday Nov 03, 2009 at 4 PM PST there are 61248 Structures [} @ | PDB Statistics @

. PROTEIN DATA BANK
WHAT'S NEW) | HELP | PRINT PD8 10 or keyword of 2 | (Advanced search
- Y N

News & Publications
Policies

FAQ

Contact

Feedback

About Us

+ Deposition

All Deposit Services
Electron Microscopy
NMR

Validation Server
BioSync Beamline
Related Tools

Advanced Search
Latest Release
Latest Publications
Sequence Search
Ligand Search
Unreleased Entries
Browse Database
Histograms

Explorer:

Last Structure: 1HVR

File Downloads
File Formats

o DECTEL | SOAAD

s smary | Lo 50 e | s | Gonery | s

RATIONAL DESIGN OF POTENT, BIOAVAILABLE, NONPEPTIDE CYCLIC
UREAS AS HIV PROTEASE INHIBITORS

Display Files v

| 1 hvr Download Files ¥

Print this Page
d B) Share this Page

DOI1:10.2210/pdb1hvr/pdb

Downloa

Primary Citation

Rational design of potent, bioavailable, nonpeptide cyclic ureas as HIV protease inhibitors.
Lam, P.Y.., Jadhav, P.K.., Eyermann, C.J.., Hodge, C.N.., Ru, Y., Bacheler, L.T.,

Meek, J.L..’, Otto, M.J..’, Rayner, M.M..’, Wong, Y.N..', etal

(1994) Science 263: 380-384

PubMed: 8278812 (7

Search Related Articles in PubMed @

PubMed Abstract:

Mechanistic information and structure-based design methods have been used to design a series of
nonpeptide cyclic ureas that are potent inhibitors of human immunodeficiency virus (HIV) protease and HIV
replication. A fundamental feature of these inhibitors is the cyclic urea ...

[ Read More & Search PubMed Abstracts ]

%+ Molecular Description

Classification: Hydrolase(acid Proteinase)’
Structure Weight: 22154.36

Molecule: HIV-1 PROTEASE
Polymer: 1 Type: polypeptide(L)
Chains: A,B

More Images...

N CTACEDT]) SimpleViewer (2]

Protein Workshop

Length: 99 !
Other Viewers v

purce

Tarmind
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About protein preparétion

Structure from PDB is often uncorrect

Check integrity of protein structure:
- Presence of all atoms in all amino acid side-chains

“Bump” check to ensure all amino acid side chains atoms are not overlapping in
the model

- PROCHECK is a suite of programs to check the stereochemical quality of
protein structures

Remove all non essential heteroatoms:

- Non-essential water molecules from the structure
- Co-cristallized ligands - > save coordinates of known inhibitor in a new file

Energy minimization is not mandatory to perform before
docking. But yes, if you do it, you would get more genuine
results.
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Using AutodockTools:
- Add polar Hs. (Bonded to heteroatoms like nitrogen or oxygen)
- Remove non-polar Hs (bonded to carbon atoms)
- Edit > Delete > Delete Hydrogens
- Edit > Hydrogens > Add > Polar Only > No Bond Order > Yes to Renumbering

Consider pH : Histidines
- File > Load Module > RepairCommands
- Edit Hydrogens > Edit Histidines Hydrogens > select HE2
(neutral, HD1; neutral, HE2; or protonated)

Create PDBQS file

— Grid > Macromolecule > Choose Macromolecule (AG3)
Automatically :
*Added Kollman charges
*Merge Non-Polar Hydrogens
*Added solvation parameters

FP7-INFRA-223791 f



TARGET: protein.tar.gz

1hvr_rec.pdbqt
1hvr_rec.A.map
1hvr_rec.C.map
1hvr_rec.HD.map
1hvr_rec.N.map
1hvr_rec.OA.map
1hvr_rec.e.map
1hvr_rec.d.map
1hvr_rec.maps.fld

1hvr_rec.maps.fld

Target in autodock4 format

Floating point number : grid point energies

Check that all the maps it reads in are compatible
Size of the grid box in each dimension x, y, z

LIGANDS: ligands.tar.gz

1hvr_lig.pdbqt

4001115_1.pdbqt
4001464 1.pdbqt
4001711_1.pdbqt

4002723 _1.pdbgt
4002577 _1.pdbgt

FP7-INFRA-223791

Co-crystallized ligand
Chembridge ligands
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DOCKING PARAMETER FILE: dpf.tar.gz

1hvr_lig.dpf

4001115_1_1hvr_rec.dpf
4001464 _1_1hvr_rec.dpf
4001711_1_1hvr_rec.dpf
4002723 1 _1hvr_rec.dpf
4002577 _1_1hvr_rec.dpf

SOFTWARE: autodock4.tar.bz2

-\

EVAsIaGrid

EV
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putlev @

intelec
seed pid time
ligand_types A C HD N 04

# diagnostic output level

# calculate internal electrostatics
# seeds for random generator
# atoms types in ligand

Hmgialildabetils

& Output Level, 0 = minimal

# atom-specific affinity map

# atom-specific affinity map

# atom-specific affinity map

# atom-specific affinity map

# atom-specific affinity map
4]

desolvmap 1hvr_rec.d.map
move 1lhvr_lig.pdbgt

about -9.2131 16.2654 28.1161

Link to map file

# desolvation map
# small molecule
# small molecule center

random
18
random
2.8
56.a
56.a

+—— Ligand

T IRILIOL CoOTUINuLES A Or Taraon
# initial quaternion
# number of active torsions
# initial dihedrals {relative) or random
# traonslation step/A
# quaternion step/deg
# torsion step/deg
i and_coefficient

unbound 8.8
rmstol 8.5
exthrg 160600.0
edmax 0.0 10060

Translation/Quaternion/Torsions

# free energy of ligand's unbound state

# cluster_tolerance/A

# external grid energy

# max initial ENergy; max number of retries

a_num_generations 27008
a_elitism 1
a_mutation_rate 8.62
a_crossover_rate 8.8
a_window_size 168
a_cauchy_alpha 8.8
a_cauchy_beta 1.8

# number of individuals in population

# maximum number of energy evaluations

# maximum number of generations

# number of top individuals to survive to next generation
# rate of gene mutation

# rate of crossover

#

# Alpha parameter of Cauchy distribution

# Beta parameter Cauchy distribution

ga_run 18
analysis

Genetic algorithm parameters

# set the above parameters for GA or LGA

# iterations of Solis & Wets local search

# consecutive successes before changing rho

# consecutive failures before changing rho

# size of local search space to sample

# lower bound on rho

# probability of performing local search on individual
# set the above Solis & Wets parameters

# compute extended ligand energy

Local Search parameters

# do this many hybrid GA-LS runs
# perform a ranked cluster analysis

_

Docking runs / Clustering

EVAsIatrid
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Startlg - EUAsiaGrid

Connect to the Ul
$ ssh kualalumpurXX@glite-tutor.ct.infn.it

Passwd: GridKUAXX
where XX=01.,,35

Start your proxy
$ voms-proxy-init —voms gilda
PassPhrase : KUALALUMPUR

FP7-INFRA-223791 [
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Inpu files

Make docking directory in your home
$ mkdir docking

Copy input files in your home and untar archive
$ cp /tmp/data_docking/* ./docking
$ cd docking
$ tar zxvf ligands.tar.gz
$ tar zxvf protein.tar.gz
$ tar zxvf dpf.tar.gz

Make a single archive
$ tar cvzf input.tar.gz *.dpf *.pdbgt 1hvr_rec*

FP7-INFRA-223791 [
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Exercice 2

Glite SUBMISSION
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Store mput data EUASIAGrid

Select your storage element

$ ICg'|nfOS|teS --VO g”da Se Avai L Space{Kb) Used Space(KB) Type SEs
38879379 8271579 n.a gilda-82.pd.infn.it
53844869 5367469 n.a vega-se.ct.infn.it
97179521 6516678 n.a dgtB2.ui.savba.sk
51184138 7225208 n.a sirius-se.ct.infn.it
8765198 18937157 n.q se.hpc.iit.bme.hu
2951238383 98718449 n.a aliserve.ct.infn.it )
2416637181 71877083 n.a sel-egee.srce.hr
1897655286 1356348 n.a gilda-se.rediris.es
685866711 6418562 n.q iceage-se-@l.ct.infn.it
1869343381 39833859 n.q fnz.hpcc.sztaki.hu

Liiml bl e Aml i dm dikme ¢ 3l

Copy and register data on grid

$ Icg-cr --vo gilda -d aliserv6.ct.infn.it -l Ifn:/grid/gilda/users/kualalumpurXX
/input.tar.gz file:/home/kualalumpurXX/docking/input.tar.gz

$ lcg-cr --vo gilda -d aliserv6.ct.infn.it - Ifn:/grid/gilda/users/kualalumpurXX
/autodock4.tar.bz2 file:/home/kualalumpurXX/docking/autodock4.tar.bz2

FP7-INFRA-223791 f



Edit the script and change modify

#! /bin/bash

glite-rb.ct.infn.it:2178
Ife-gilda.ct.infn.it
Ifc

#retrieve the software
lcg-cp —-vo gilda Lfn:/grid/gilda/users/kualalumpurz2é/docking/autodock4.tar.bz2 file:" “/autodock4.tar .bz2
tar -jxf autodock4.tar.bz2

#retrieve the input data
lecg-cp --vo gilda Lfn:/grid/gildasusers/kualalumpurzé/docking/input.tar.gz file:" “Ainput.tar.gz
tar -zxf input.tar.gz

#run autodock4

-z unlimited
i in “ls *.dpf
Jautodock4 $i $i.dlg

#zave the results back
i “le ¥ .dlg?

lcg-cr --vo gilda file: oo /i iceage-se-Al.ct.infn.it Ifh:/grid/gildosusersskualalumpur26/docking/$1

-\

EVASIaGrid

EV
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Docklng jd| A

Type = "Job";

JobType = "Normal";
Executable = "/bin/bash";
StdOutput = "job.out";

StdError = "job.err";
InputSandbox = {"docking.sh"};

nmn

OutputSandbox = {"job.err","job.out"};
Arguments = "docking.sh";

ShallowRetryCount = 0;

FP7-INFRA-223791 f



=

EV Grid

Job

Create a delegation ID to the WMS by creating a
delegation identifier using your username

$ glite-wms-job-delegate-proxy -d kualalumpurXX
Submit a job

$ glite-wms—job-submit —d kualalumpurXX docking.jdI

Connecting to the service https://gilda-wms-82.ct.infn.it:7443/glite_wms_wmproxy_server

glite-wms-job-submit Success

The job has been successfully submitted to the WMProxy
Your job identifier is:

https://gilda-1b-B1.ct.infn.it :9808/XfDhzPvFYuthZLKgTcszgg




Job:Status

submitted
A 4
waiting
Check your job status
A 4
ready
$ glite-wms-job-status https://gilda-1b-01.ct.infn.it:9000
A 4
[ST/NwWtFLDUOLLsNQmMo9BwWA
scheduled
A 4
[varennadldglite-tutor docking]$ glite-wms-job-status https://gilda-lb-81.ct.infn.it:9008/pDYyXNSiKooZrZjedsocDg running
AR AR AR AR AR AR AR KRR AR AR AR AR AR AR KRR KRR AR AR AR AR AR K
BOOKKEEPING INFORMATION: Y
| | o | | done
Status info for the Job : https://gilda-1lb-81.ct.infn.it:9880/pDYyvXNSiKooZrZjedsocDg
Current Status: Running
Status Reason: Job successfully submitted to Globus  Z
Destination: cel-egee.srce.hr :2119/jobmanager-sge-prod
Submitted: Tue May 12 11:59:24 2089 CEST outputready
KA AR AR AR AR AORAOR AR KRR AR AR AR AOR AR KRR AR AR AR AOR KK
A 4
cleared

FP7-INFRA-223791 f
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Retrieve you dlg from grid in your home

$ foriin “cat list_dlg’; do Icg-cp --vo gilda Ifn:/grid/gilda/users
/kualalumpurXX/docking/$i file: pwd’/$i ; done

Results analysis...

FP7-INFRA-223791 f



EV Grid

Extract and rank Binding Energy for best conformations
$ ./energy.sh

MODEL K

USER Run = 7

USER Cluster Rank = 1
USER Number of conformations in this cluster = 7
USER

USER RMSD from reference structure
USER

USER Estimated Free Energy of Binding
USER Estimated Inhibition Constant, Ki

37.608 A

[

~7.22 keal/mol  [=(1)+(2)+(3)-(4)]
5.11 uM (micromolar) [Temperature = 298.15 K]

USER

USER (1) Final Intermolecular Energy -7.49 kecal/mol
USER vdW + Hbond + desolv Energy -4.52 kecal/mol
USER Electrostatic Energy .98 keal/mol

-8.82 kcal/mol
+8.27 keal/mol
-8.82 kcal/mol

USER (2) Final Total Internal Energy
USER (3) Torsional Free Energy
USER (4) Unbound System's Energy

wewonowowom
|
N

USER . - . .
e [kualalumpur3B@glite-tutor results_analysis]$ ./energy.sh
USER  DPF = 4882723_1_ihvr_rec.dpf :

USER NEWDPF move 4802723_1 .pdbqt _16'35 1hvr—llg'dpf'dlg

USER  NEWDPF bout  -3.207000 -1.389600 -2.574900

USER  MEWDPF tran®  -10.227483 16.611496 30.661565 -7 '19 4882723_1_1?1\!1' -Tec 'dpf .d lg

USER  NEWDPF axisangled -0.769077 B.345317 -0.537845 115.819078 _

USER  NEWDPF quaternion@ -0.651570 B.292556 -B.455668 ©.531258 6.59 4801711_1_1hvr_rec 'dpf . lg

USER  NEWDPF ndike 1 -

UGER - NEDPE ndine 5.68 4001115_1_1hvr_rec.dpf .dlg

USER -

usER § , s e 0 ae 5.31 4808329_1_1hvr_rec.dpf.dlg

ATOM 1 ctoligd -8.964 14.775 32.507 -8.3¢ -0.00  +0.033 37.600 -4.79 4000321_1_1hvr_rec.dpf.d [g

ATOM 2 €2 ligd -9.980 14.610 33.451 -8.29 -0.61  +0.039 37.600 i . an H

ATOM 303 ligd _11.461 16.873 32.201 -8.14 -9.62  +0.051 37.600 by VDR, TSRO - SN SO

ATOM 4 C4 ligd -10.451 16.257 31.234 -B.26 -0.08  +0.003 37.600

ATOM 5 C5 ligd -18.355 16.999 30.826 -8.32 -9.08  +0.903 37.600

ATOM 6 C6 ligd -9.226 15.603 31.408 -8.27 -0.61  +0.043 37.600

ATOM 7 €7 ligd -11.211 15.248 33.302 -8.26 -8.61  +0.969 37.600

ATOM 8 C8 ligd -9.898 16.777 29.503 -08.26 -0.61 0.620 37.600 s

ATOM 9 C9 ligd -11.340 17.866 29.335 -0.27 -0.47 :8.2'?3 37.600 « The Iowest IS the best »
ATOM 10 €18 ligd -8.559 17.373 28.251 -8.27 -0.67  +0.085 37.600

ATOM 11 Ci1 ligd -9.714 17.894 27.384 -8.27 -8.33  +0.238 37.600

ATOM 12 N ligd -§.421 15.948 30.340 -0.12 +0.18  -0.358 37.600

ATOM 13 N2 ligd -10.684 18.677 28.236 -0.36 +08.19  -B.B71 37.600

ATOM 14 H ligd -7.487 15.501 30.189 +0.07 -0.61  +0.166 37.600

ATOM 15 H ligd -11.488 19.883 27.570 -8.23 -1.20  +0.277 37.600

ATOM 16 H3B lig d -18.135 19.427 28.703 -8.22 -1.14  +8.277 37.600

ATOM 17 01 ligd -12.183 15.965 34.239 -0.42 +08.087  -0.356 37.600

ATOM 18 C12 ligd -11.818 15.287 35.601 -0.30 -8.05  +0.210 37.600

TER
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Select best conformations and extract its coordinates
from dlg file

Copy the « best dlg » (having the lowest energy) in
/home/kualalumpurXX/docking/results _analysis

$ ./get_best_docking.sh 4002723 1 _1hvr_rec.dpf.dlg

You obtain the docked conformation
4002723 1 _1hvr_rec.dpf.pdbqg

FP7-INFRA-223791 f
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4002723 1
docked

4002723 1

23791




EV Grid

Exercice 2

WISDOM SUBMISSION
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Data Manager

I Database

Data Management APIs L_,

Service
Clle.nt —
Services

I

Task Manager

[ Tasks Management APls

---------------------
* Yo

Information
System

AMGA

Job Manager
FL W
791
— 379 r
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O ©

User Job
- Create a new task/ -List installed
service, specify software on the
required tags WN (tags)
= SE l ~ - Request task

Task manager
@ Create the new
task / service folder
Return task id

@ List possible
services according
to the tags
\_Returnonetask

FP7-INFRA-223791 f
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Create and
manage
Tasks data

manage

Information tasks
System

(AMGA)

Get a task
. (software info and

Get corresponding \_/ parameters)

information '\/'

Store back data
and metadata ;’

Storage | | Computing
Element )\ Element

Remove task

3 | Get corresponding ‘ '
tool package and ( \
retrieve \4/ Execute task

corresponding data
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WlSDOM subm|SS|on EUASsiaGric

Store a tar.gz of all the necessary files on the grid
— Already done in the previous exercise

Service DOCKING.tar.gz is already deployed (/grid/gilda
/users/services/DOCKING.tar.gz)

Create a task
— Use the script createTask

— .[createTask -s {name_service} -u {nom_user} -a {arguments}
. With:
— Nom_service=DOCKING
— Nom_utilisateur=varennaXX

— Arguments=name of the archive without tar.gz: input
— ./createTask —s DOCKING -u varennaXX -a input

— Result obtain:

» {name_service}.{name_user}.{number}
Example: DOCKING.varennaXX.7

FP7-INFRA-223791 f
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WISDOM subm|SS|on EUASiaGrid

Check the status of the task

— Use the script getStatus
— Put in parameter the Taskld
— Example:./getStatus DOCKING.varennaXX.7
— 3 possible results: waiting, running, done

— You would be able to see the agents running on the following web site:
http.//amga02.lpc-rd.fr/plate-forme-biolnfo/

Retrieve the results

— Results are stored in: /grid/gilda/users/varennaXX/docking/

— The name of the archive created corresponds to {name of the
archive} result.tar.gz

FP7-INFRA-223791 f



